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About this manual1.

Copyrights1.1.

The information in this document is subject to change without notice and should not be
construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for any
errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental, or consequential
damages of any nature or kind arising from the use of this document, nor shall ABB Oy
be liable for incidental or consequential damages arising from use of any software or
hardware described in this document.

This document and parts thereof must not be reproduced or copied without written per-
mission from ABB Oy, and the contents thereof must not be imparted to a third party
nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and
may be used, copied, or disclosed only in accordance with the terms of such license.

© Copyright 2011 ABB. All rights reserved.

Trademarks1.2.

ABB is a registered trademark of ABB Group. All other brand or product names men-
tioned in this document may be trademarks or registered trademarks of their respective
holders.

General1.3.

This manual provides thorough information on Station Automation COM600 (later
referred to as COM600) Human Machine Interface (HMI) and the central concepts related
to it. Information in this manual is intended for operators performing configurations
using the HMI.

Document conventions1.4.

The following conventions are used for the presentation of material:
• The words in names of screen elements (for example, the title in the title bar of a

window, the label for a field of a dialog box) are initially capitalized.
• Capital letters are used for the name of a keyboard key if it is labeled on the keyboard.

For example, press the ENTER key.
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• Lowercase letters are used for the name of a keyboard key that is not labeled on the
keyboard. For example, the space bar, comma key, and so on.

• Press CTRL+C indicates that you must hold down the CTRL key while pressing
the C key (to copy a selected object in this case).

• Press ESC E C indicates that you press and release each key in sequence (to copy
a selected object in this case).

• The names of push and toggle buttons are boldfaced. For example, click OK.
• The names of menus and menu items are boldfaced. For example, the  File menu.

• The following convention is used for menu operations: MenuName > Menu-
Item > CascadedMenuItem. For example: select File > New > Type.

• The Start menu name always refers to the Start menu on the Windows taskbar.
• System prompts/messages and user responses/input are shown in the Courier font.

For example, if you enter a value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 - 30 .

• You can be asked to enter the string MIF349 in a field. The string is shown as follows
in the procedure:

MIF349
• Variables are shown using lowercase letters:

sequence name

Use of symbols1.5.

This publication includes warning, caution, and information icons that point out safety-
related conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should be interpreted as follows.

The electrical warning icon indicates the presence of a hazard
which could result in electrical shock.

The warning icon indicates the presence of a hazard which
could result in personal injury.

The caution icon indicates important information or warning
related to the concept discussed in the text. It may indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.
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The information icon alerts the reader to relevant facts and
conditions.

The tip icon indicates advice on, for example, how to design
your project or how to use a certain function.

Terminology1.6.

The following is a list of terms associated with COM600 that you should be familiar
with. The list contains terms that are unique to ABB or have a usage or definition that
is different from standard industry usage.

DescriptionTerm

An abnormal state of a condition.Alarm

An OPC service for providing information about alarms and
events to OPC clients.

Alarms and Events; AE

An OPC service for providing information about process data to
OPC clients.

Data Access; DA

Part of a logical node object representing specific information,
for example, status, or measurement. From an object-oriented
point of view, a data object is an instance of a class data object.
DOs are normally used as transaction objects; that is, they are
data structures.

Data Object; DO

The data set is the content basis for reporting and logging. The
data set contains references to the data and data attribute val-
ues.

Data Set

A physical device that behaves as its own communication node
in the network, for example, protection relay.

Device

Change of process data or an OPC internal value. Normally, an
event consists of value, quality, and timestamp.

Event

A physical IEC 61850 device that behaves as its own commu-
nication node in the IEC 61850 protocol.

Intelligent Electronic Device

Representation of a group of functions. Each function is defined
as a logical node. A physical device consists of one or several
LDs.

Logical Device; LD

The smallest part of a function that exchanges data. An LN is
an object defined by its data and methods.

Logical Node; LN

A communication protocol developed by Echelon.LON

A proprietary method of ABB on top of the standard LON pro-
tocol.

LON Application Guideline for
substation automation; LAG
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DescriptionTerm

Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

OPC

Representation of a connection to the data source within the
OPC server. An OPC item is identified by a string <object
path>:<property name>. Associated with each OPC item are
Value, Quality, and Time Stamp.

OPC item

Named data item.Property

The report control block controls the reporting processes for
event data as they occur. The reporting process continues as
long as the communication is available.

Report Control Block

ABB proprietary communication protocol used in substation
automation.

SPA

Protection and/or Control Product supporting the SPA protocol
version 2.5 or earlier.

SPA device

XML-based description language for configurations of electrical
substation IEDs. Defined in IEC 61850 standard.

Substation Configuration Lan-
guage; SCL

Abbreviations1.7.

The following is a list of abbreviations associated with COM600 that you should be
familiar with. See also 1.6, Terminology.

DescriptionAbbreviation

Alarms and EventsAE

Application Service Data UnitASDU

Buffered Report Control BlockBRCB

Data AccessDA

Data Message Code DefinitionDMCD

Data ObjectDO

Gateway, component connecting two communication networks togetherGW

Human Machine InterfaceHMI

International Electrotechnical CommissionIEC

Intelligent Electronic DeviceIED

LON Application Guideline for substation automationLAG

Local Area NetworkLAN

Logical DeviceLD
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DescriptionAbbreviation

LonMark interoperable device communicating in LonWorks network. In
this document, the term is used for devices that do not support the ABB
LON/LAG communication.

LMK

Logical NodeLN

LON SPA GatewayLSG

Network Control CenterNCC

Norwegian User ConventionNUC

Network VariableNV

Object Linking and EmbeddingOLE

OLE for Process ControlOPC

Protection & ControlP&C

Request To SendRTS

Substation AutomationSA

Station Automation Builder 600SAB600

Substation Configuration LanguageSCL

Single Line DiagramSLD

Simple Network Management ProtocolSNMP

Simple Network Time ProtocolSNTP

Simple Object Access ProtocolSOAP

Report Control BlockRCB

Unbuffered Report Control BlockURCB

eXtended Markup LanguageXML

Related documents1.8.

MRS numberName of the manual

1MRS756125COM600 User’s Manual

1MRS756705COM600 Operator's Manual

1MRS756739COM600 Data Historian Operator's Manual

1MRS756566DNP LAN/WAN Master (OPC)

1MRS756567DNP Serial Master (OPC)

1MRS755496DNP LAN/WAN Slave (OPC)

1MRS755495DNP Serial Slave (OPC)

1MRS755382IEC 60870-5-101 Slave (OPC)
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MRS numberName of the manual

1MRS756703IEC 60870-5-101 Master (OPC)

1MRS752278IEC 60870-5-103 Master (OPC)

1MRS755384IEC 60870-5-104 Slave (OPC)

1MRS756704IEC 60870-5-104 Master (OPC)

1MRS755321IEC 61850 Master (OPC)

1MRS756738Logic Processor User's Manual

1MRS755284LON-LAG Master (OPC)

1MRS756569MNS iS Connectivity (OPC)

1MRS756126Modbus Serial Master (OPC)

1MRS756913Modbus Serial Slave (OPC)

1MRS756445Modbus TCP Master (OPC)

1MRS756914Modbus TCP Slave (OPC)

1MRS752275SPA Master (OPC)

1MRS755497SPA Router (OPC)

Document revisions1.9.

HistoryProduct revisionDocument version/date

Document created3.3A/13.2.2009

Document revised3.4B/06.11.2009

Document revised3.5C/30.6.2011
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Introduction2.

Overview of COM6002.1.

COM600 provides gateway functions for mapping signals between protection and control
IEDs in industrial or utility substations and higher-level systems. It further includes an
optional HMI that provides data and information from the substation to the users.

COM600 gathers data from protection and control IEDs and from process devices using
different communication protocols. The supported protocols can be combined freely in
one station computer, limited only by the number of hardware interfaces and the license.
COM600 uses web technology to display data to different users in a professional and
user-friendly manner. The web technology is further used to transfer information to a
network control centre (NCC) or distributed control system (DCS).

COM600 benefits from the potential of the IEC 61850 standard by using the IEC 61850-
6 substation configuration language (SCL) and IEC 61850 -7 communications modeling
regardless of protocol used. As the IEC 61850 data modeling is used for all communic-
ation protocols the gateway cross-reference is done in the same way regardless of the
protocol, for example IEC 61850-8-1 or DNP3.

With the optional web HMI, COM600 can be used for efficient substation visualization,
monitoring, and control. The supported browsers are Microsoft Internet Explorer (requires
Adobe SVG viewer 3.03), Mozilla Firefox®, and Opera. Measured values from process
devices are displayed on the HMI. Single-line diagrams can be used to view any available
measured values from the process devices.

Predefined user account2.2.

HMI has a predefined user account with administrator rights.

• User name: admin
• Password: adminadmin

When you log in for the first time as an administrator, change the password before you
proceed using HMI. If you forget the new password, restore the factory settings with the
Management tool in SAB600. After the factory settings have been restored, you can only
log in with the predefined administrator password mentioned above.
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Configuration3.

About this section3.1.

This section describes the configuration tasks for HMI.

Operating system access permissions using local
browser

3.2.

When using COM600 browser locally in the COM600 computer, it can be specified
whether the browser locks down the access to the operating system functions for non-
administrator users.

The C:\Program Files\COM610 GW SW\WebBrowser folder in the COM600 computer
contains a config.ini file, which has an option called useLockedMode. By default it is set
to value 0, which means that no locking is done. When set to 1, the access to operating
system functions is disabled from non-administrator users.

Prerequisites3.3.

Before you start configuring the HMI, pay attention to the following:
1. Prepare the communication structure as instructed in COM600 User's Manual.
2. Make sure that you have the necessary connectivity packages or SCL description

files that can help you in the configuration process.
3. Outline the Single Line Diagram structure you want to create for your system.

Use the Management function to update the COM600 communication configuration at
least once before you start the substation configuration. If you do not update the config-
uration, the statuses of objects in HMI Single Line Diagram can be bad or uncertain.

To fix the statuses of objects in Single Line Diagram:
1. Save the substation configuration.
2. Update the COM600 configuration with the Management function by changing any

property in SLD Editor and by clicking Apply.
3. Update the COM600 configuration again using with the Management function.
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Creating substation structure and communication
structure

3.4.

Creating substation and communication structures with SCL
descriptions or connectivity packages

3.4.1.

To create the substation and communication structures with SCL descriptions or con-
nectivity packages:
1. Create Substation and Voltage level objects to the substation structure.
2. Create the OPC Server and communication channel objects to the communication

structure.
3. Create the IED object below the communication channel and use either the connectiv-

ity package or IED SCL description file to populate automatically the structure
below the IED. The substation structure is automatically populated with primary
apparatus objects described in the connectivity package or SCL descriptions. You
may be prompted to give some information to guide the process, for example choose
a voltage level or give a bay name.

4. Repeat step 3 for each IED.
5. Fine-tune the SLD layout (assign colors, specify incoming/outgoing feeders, and

so on) by modifying or adding objects. Additionally you might need to create busbar
connections, see 3.4.2,  Creating substation structure manually .

6. Download the configuration to the COM600 computer.

Creating substation structure manually3.4.2.

The following is an overview of creating a substation structure manually. For a more
detailed description, see 3.4.3, Adding Gateway object, 3.4.4, Adding Substation,
3.4.5, Adding voltage level object, 3.4.6, Adding bay object and 3.4.7, Adding busbar
object.

Before you can create a substation structure, you have to create
a communication structure with OPC Server and communica-
tion channel objects, IEDs, Logical Devices, Logical Nodes
and Data objects.

To create the substation structure manually:
1. Create Gateway, Substation and Voltage level objects to the substation structure.
2. Add bays and busbars, and design their layout using the SLD Editor. Connect your

substation structure objects to communication structure (logical nodes) using the
data connection function, see 3.6.1, General about Data connection .
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If the configurations of the bays are similar, you can copy the
bay object and the data it contains. This way you do not have
to add each bay separately to the substation structure.

3. Design your voltage level layout by connecting busbars and bays and relocating
them with the SLD Editor. Open the SLD Editor by right-clicking the voltage level
object.

4. Design your substation layout by connecting possible transformer windings between
voltage levels. Relocate voltage levels with the SLD Editor. Open the SLD Editor
by right-clicking the substation.

5. Fine-tune SLD settings, for example fonts and colors, see 3.6.2, Settings .

Adding Gateway object3.4.3.

To link the Gateway object to the substation structure:
1. Select the Gateway object in the Communication structure.
2. Copy the Gateway object by selecting Edit > Copy or by right-clicking the object

and selecting Copy.
3. Open the Substation structure.
4. Select the project name and right-click it.
5. Select Paste Link, see Figure 3.4.3-1.
6. Modify the Gateway properties if necessary.

linkGW.bmp

Figure 3.4.3-1 Linking a Gateway object

The object properties for the Gateway are presented in Table 3.4.3-1.

Table 3.4.3-1 Object properties for Gateway
DescriptionVale or Value range/DefaultProperty/Para-

meter

Basic
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DescriptionVale or Value range/DefaultProperty/Para-
meter

Defines if local audio alarm is enabled in
COM600 hardware.

True

False

Default: True

COM600 Audio
Alarm

Version of COM600.Default: 3.3COM600 Version

Defines the path where event list log is
store.

Default: noneEvent File Path

Defines the capacity of Event List in
WebHMI.

0...65535

Default: 1000

Event List Capacity

Defines which Web HMI client IP
addresses are reserved for local use inside
station. This information is used for the
station/remote switch handling. E.g.
"192.168.7."

Station/remote IP
Address

Defines if Watch Dog is enabled.True

False

Default: True

Watch Dog Enabled

Defines if audio alarm is enabled for the
Web HMI clients.

True

False

Default: True

Web Client Audio
Alarm

External Watchdog

The full path of the command OPC item.
E.g.
"ABB.SPA_OPC_DA_Server.Instance[1]#SPAChan-
nel\SPA-
COM\SACO16D2B\LD1\LLN0\Wd\ctlVal".

Command OPC
Item Path

The interval in seconds that determines
how often the command is executed.

0...65535

Default: 5

Command Write
Interval

The value that is written to the command
OPC item.

0...65535

Default: 1

Command Write
Value

DCOM

IP address of COM600 computer.IP Address

Adding Substation3.4.4.

After the Gateway object has been successfully added, you can continue building the
object tree by adding substation objects.
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To add a substation object:
1. Select the Gateway object and right-click it.
2. Add a substation object by selecting New > Functional > Substation.
3. Rename the new object. The names of the substation objects have to be unique.
4. Modify substation properties if necessary.

You can define only one substation per project.

Adding voltage level object3.4.5.

After the substation object has been successfully added, you can continue building the
object tree by adding voltage level objects.

To add a voltage level object:
1. Select the substation object and right-click it.
2. Add a voltage level object by selecting New > Functional > Voltage Level.
3. Rename the new object. The names of the voltage level objects have to be unique.
4. Modify voltage level properties if necessary.

The object properties for voltage level are presented in Table 3.4.5-1.

Table 3.4.5-1 Object properties for voltage level
DescriptionVale or Value range/DefaultProperty/Para-

meter

Basic

MultiplierDefault: kiloMultiplier

Nominal voltage.20Voltage

Adding bay object3.4.6.

After the voltage level object has been successfully added, you can continue building
the object tree by adding bay objects.

To add a bay object:
1. Select the voltage level object and right-click it.
2. Add a bay object by selecting New > Functional > Bay.
3. Rename the new object. The names of the busbar objects have to be unique.
4. Modify bay properties if necessary.
5. Design the bay layout using SLD editor, see 3.5.1, Using the SLD Editor.
6. Use the data connection function, see 3.6.1, General about Data connection.
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Adding busbar object3.4.7.

After the voltage level object has been successfully added, you can continue building
the object tree by adding busbar objects.

To add a busbar object:
1. Select the voltage level object and right-click it.
2. Add a busbar object by selecting New > Functional > BusBar.
3. Rename the new object. The names of the busbar objects have to be unique.
4. Modify busbar properties if necessary.
5. Design the busbar layout using SLD editor, see 3.5.1, Using the SLD Editor.

Single Line Diagram3.5.

Using the SLD Editor3.5.1.

To open the SLD Editor, select substation, voltage level, bus, or bay object and right-
click them. Then select SLD Editor from the menu. The higher level contains the layout
of the lower levels.

With the SLD Editor you can add objects to the Single Line Diagram, modify existing
objects, and specify electrical connections. You can also fine-tune the layout of the dia-
gram and add and modify descriptive texts. You can drag and drop symbols needed in
the SLD from the symbol library. Click Preview to preview the layout of the diagram.
The supported browsers are Microsoft Internet Explorer (requires Adobe SVG viewer
3.03), Mozilla Firefox®, and Opera.
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SLDPreview.bmp

Figure 3.5.1-1 SLD Editor preview

To open the SLD Editor Tool:
1. Click the Substation structure tab.
2. Select the Bay or the Busbar object.
3. Right-click on the Bay or the Busbar object and select SLD Editor.

or
From the main toolbar, select Tools > SLD Editor.

Creating a diagram with the SLD Editor

To create a diagram with the SLD Editor:
1. In the Symbols view, click the tabs to view the different sets of symbols, see Fig-

ure 3.5.1-2.
2. Click a symbol you want to use and drag it with the mouse to the Single Line Diagram

view.
3. Place Connectivity Nodes between switches and transformers that will be connected.
4. Select the Direct Link tool from the SLD toolbar. Link the symbols together by

clicking first the start and then the end point of a connection.
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Symbols can be graphically grouped by drawing a rectangle border around them by
selecting the Rectangle button. This feature is only a visual aid and does not affect the
functionality of the SLD.

SLD_symbols.bmp

Figure 3.5.1-2 SLD symbols

Bay SLD

To create a bay SLD:
1. Add primary objects (Switchgear objects, measurement transformers, and power

transformers).
2. Rename the primary object using the name property in the property grid. This name

is used in HMI for the object.
3. Add primary Connection objects (for example, feeders, earth symbols).
4. Add Connectivity Nodes.

• Switchgears are connected to each other with a connectivity node.
• Feeder objects are connected to switchgear objects with a connectivity node.
• Transformer objects are connected to switchgear objects with a connectivity

node.
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Do not add connectivity nodes to the connection between
the busbar and the bay switchgears.

Do not add connectivity nodes between the earth symbol
and the switchgear object (disconnector).

To connect a power transformer to another bay, create a
connectivity node in the target bay (not in the bay where
the power transformer is located).

Default relative sizes of the symbols can be configured
using the Settings tool of the Gateway object. Default
values can be overriden for individual symbol instances
with the Relative Size property of the symbol instance.
This makes it possible to have individual sizes for sym-
bols in the SLD.

5. Add Via points, if you want the line to follow a certain route.
6. Connect objects

• Activate the Direct Link tool from the tool bar.
• Link two objects together by selecting their link points.
Additionally you can add for example a Bay Switch indicator, annotations, and
measurement text boxes.
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Bay_SLD_34.bmp

Figure 3.5.1-3 The Bay SLD view

Measurement text box configuration

To configure the Measurement text box, use the Data Connect
function to connect the measurement logical nodes from the
communication structure to the bay.

To configure the Measurement text box:
1. Right-click the object and select Configure Measurement function from the menu.
2. Using the configuration dialog, select the measurements to be shown in HMI.

If the IED does not provide a unit for the measurement, it is
possible to specify the unit here.
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Measurement_configuration.jpg

Figure 3.5.1-4 The Measurement Configuration dialog

Bay Switch Indicator configuration

To configure the Bay Switch Indicator, use the Data Connect
function to connect the logical node containing the Loc
information (LLN0) from the communication structure to the
bay.

To configure the Bay Switch Indicator:
1. Right-click the object and select Configure Bay Switch Indicator from the menu.
2. Using the configuration dialog, select the source for the local remote switch indication

(for example LLN0.Loc.stVal) to be used in HMI.
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Bay_Switch_indicator_configuration.jpg

Figure 3.5.1-5 The Bay Switch Indicator configuration dialog

Busbar SLD

To create a busbar SLD:
1. Add Busbar start and end objects (only one start and end point is allowed).
2. Add a Connectivity Node (one connectivity node is enough to connect all bays to

this busbar).
3. Connect the objects.

• Activate the Direct Link tool from the tool bar.
• Two objects linked together by selecting their link points.

You can adjust the size of busbar in the bay and voltage level views as well as the busbar
view. You can also add annotations.
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Busbar_SLD_34.bmp

Figure 3.5.1-6 The Busbar SLD view

Busbar Coloring

Busbar Coloring is automatically configured when the SLD is drawn. Connecting
switchgear objects together specifies their electrical connections, which is used during
runtime to calculate the proper coloring. Settings tool in the substation gateway object
has tab page for the Busbar coloring, where, for example, the used colors can be modified.
The value of the voltage property on the voltage level object is used for the voltage level
based busbar coloring mode.

Configuring the powered state for incoming feeder and generator

1. Select the IFL or GEN object in the SLD editor.
2. Right-click it, and select Configure Powered Rule from the menu.

There are three different rules for detecting the powered state. Configure at least one of
the following three rules so that the busbar coloring works correctly.

• A measurement value must be greater than the configured value.
• A data object value is equal to the configured value.
• A data object value is unequal to the configured value.

If the result of all configured rules is true, the object is considered as powered by the
busbar coloring logic.
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sldPoweredRule.bmp

Figure 3.5.1-7 The Powered rule dialog

Voltage level SLD

To create a voltage level SLD:
1. Drag the bays to correct locations in the SLD (name of the selected bay can be seen

in the property grid).
2. Connect bays to busbars. Select a bay, right-click it and select Connect to a Busbar

from the menu.
3. In the configuration dialog, select the corresponding switchgear and the busbar

object to connect them.
4. If you need to connect a bay to another directly, select a bay, right-click it, and select

Connect to a Bay.
By doing this the bays will be connected via regular line.

The SLD Editor shows the lines between the bays and
the busbar connected to the same point in the busbar.
However, the lines are drawn to separate locations in
HMI.

5. If you want to fine-tune the SLD Editor layout for the connection lines, you can add
a StopAt object from menu of the line. Move the StopAt point to the correct location
in the busbar.

You can also add annotations.
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Voltage_level_SLD_34.bmp

Figure 3.5.1-8 The voltage level SLD view

Substation SLD

To create a substation SLD:
1. If you have more than one voltage level object, drag the objects to correct locations

in the SLD.
2. Voltage levels are connected to each other via a power transformer. Select a voltage

level containing the transformer, right-click it and select Connect Winding to a bay
function from the menu.

3. Using the configuration dialog, you can select winding and the target bay/connectivity
node.

4. Add Station switch indicator (local/remote) Configuration.

To configure the Station Switch Indicator, use the Data Con-
nect function to connect the logical node containing the
information (SPS CDC) from the communication structure to
the substation.
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SLD_Editor_Tool_34.bmp

Figure 3.5.1-9 Substation SLD view

Data connection3.6.

General about Data connection3.6.1.

The Data Connection function is used to connect the substation structure objects to the
communication structure. Process data values based on the communication structure
objects are used to update the symbol states in HMI. It is also used to get object
descriptions based on the substation structure names to the alarm and event lists.

Any data object that has event class defined in the communic-
ation structure, must be linked to the substation structure to
get the proper description to the alarm and event.

Before you can use the Data connection function, create the communication structure,
see 3.4.1, Creating substation and communication structures with SCL descriptions or
connectivity packages.

To connect the substation structure objects to the communication structure:
1. In the Substation structure select a Substation, Bay, or Voltage level object and

right-click it. Select Data Connection to open the Data connection function.
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The objects in the substation structure are shown on the left side of the Data connec-
tion window. The logical nodes that can be attached to the objects are shown on the
right side of the Data connection window.

2. Click a substation structure object on the left side of the Data connection window.
The logical nodes that can be attached to the objects are listed in the structure on
the right side of the window.

3. Double-click the logical node to attach/detach it to the correct substation structure
object.

4. Click OK to save the changes.

Data_connection.bmp

Figure 3.6.1-1 The Data connection window

Settings3.6.2.

You can define SLD settings in the Settings dialog. To open the Settings dialog, right-
click the Gateway object and select Settings.

The Settings dialog contains the following tabs:
• Generic: You can define general settings, for example the symbol set (ANSI or

IEC) and element size.
• Alarm Settings: You can define color settings and appearance for the alarms.
• Measurement Status: You can define color settings for different alarm levels.
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• Default Colors: You can modify the default colors of devices.
• Fonts: You can modify the font definitions.
• Measurement Precisions: You can adjust the precision settings of the measurements.
• Bus Bar Coloring: You can define busbar colors and busbar settings.
• Name Display: You can define name display settings. These settings define how

and if name is displayed next to the symbol.
• Resource Text Sets: You can modify measurement, quality, or local/remote resource

texts. Measurement texts affect the Measurements page of HMI. Quality texts affect
Alarm and Event Lists in HMI. Local/Remote texts are displayed with the Bay and
Station Indicator.

Alarm and event handling3.7.

General about alarm and event objects3.7.1.

Alarm and event objects define the types of events and alarms that are generated and the
alarm and event messages displayed in HMI. It is possible to modify existing alarm and
event objects (see 3.7.2, Modifying existing alarm and event objects) and to create new
objects (see 3.7.3, Creating new alarm and event objects).

The communication structure contains the following event groups:
• Process Event Definitions
• Communication Diagnostic Event Definitions
• Common Event Settings

event_classes.bmp

Figure 3.7.1-1 Event groups
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Modifying existing alarm and event objects3.7.2.

To modify existing alarm and event objects:
1. Select the event class in the communication tree structure.
2. Select the desired event object from the list.
3. Right-click the event object and select Properties.
4. Make the necessary modifications to the event object in the Object Properties

window.

Creating new alarm and event objects3.7.3.

To create new alarm and event objects:
1. Select the event class group in the communication structure and right-click it.
2. Select New > Event Classes.
3. Select the desired event class type from the list. The new object is added to the

communication structure. Rename the object.
4. Right-click the event object and select Properties.
5. Make the necessary modifications to the event object in the Object Properties

window.

Connecting alarm or event objects to data objects3.7.4.

Data objects are connected to event classes by selecting the used event class from the
properties of the data object. Depending on the data class, the object can have an event
class property both for indication and control events or only one of them. These properties
define the event classes that are used with the data object.

Data Historian3.8.

The COM600 data historian is a real-time database designed and optimized for process
information management and extensive history recording. The data historian is based
on ABB’s cpmPlus Knowledge Manager software. It combines the benefits of an easy-
to-use real-time database with industrial reliability, performance, and real-time function-
ality to provide an excellent platform for process information management.

The data historian can be used for accurate process performance monitoring by following
process and equipment performance calculations with real-time and history values.
Better understanding of the process behaviour by joining time-based process measure-
ments with production and maintenance events helps the user to understand the process
dynamics. It further provides required information for learning how to keep the process
running. High performance and reliability, together with maintenance-free operation,
provide a solid platform for trending.

The optional data historian functionality offers means of storing, analyzing and
presenting process data.
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HMI_Data_Historian_menu.bmp

Figure 3.8-1 Data Historian menu item shown in Web HMI

For more information about configuring the data historian, see section Configuring Data
historian in COM600 User's Manual. For information about the actual usage of data
historian information, see COM600 Data Historian Operator's Manual.

Customizing IED parameter settings3.9.

To have the parameters of an IED added automatically to the selections list, the connectiv-
ity package for the IED that supports the parameter information must be installed.

With the Parameter Selection tool of SAB600, you can select the parameters that are
shown in the Parameter Setting view in HMI. This option helps you to create a user-
friendly view for HMI.

Selecting parameters

To select parameters:
1. Click the Communication tab on the left.
2. Right-click the IED object and select Parameter Filtering Tool. A Parameter Fil-

tering view opens. All the logical nodes the device contains are displayed on the
left side of the Parameter Filtering view.

3. Click a logical node to view all the possible parameters.
4. Select the check box of the parameters you want to be displayed in the Parameter

Setting view of HMI, see Figure 3.9-1. To select all parameters, click Select All.
To unselect all parameters, click Deselect All.

5. Click Apply to save the selected parameters.
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parameter_filtering_tool.bmp

Figure 3.9-1 Parameter Filtering Tool

Adding new parameters

You can add a new parameter to the Parameter Filtering view. If no connectivity package
is available or the connectivity package does not contain a specific parameter for your
needs, you can add new parameters using the Add Parameter Form.

To add a new parameter:
1. Click Add Parameter in the Parameter Filtering view. The Add Parameter Form

window opens, see Figure 3.9-2.
In the Add Parameter Form window you can fill in the information on the parameter
you want to add or select a suitable option from a drop-down list.

2. After you have added all necessary information, click Apply to add the parameter
to the Parameter Filtering view.
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Add_parameter_form.bmp

Figure 3.9-2 The Add Parameter Form window

If a parameter row has been selected in the Parameter Filtering
view, the Add Parameter button opens the selected parameter.
The changes are made to the selected parameter.

When using SPA parametrisation, the Parameter field in the tool specifies the used SPA
parameter (for example 052S002). The syntax is [SPA Channel][SPA Data Category][SPA
Data Number].

When using IEC61850 parametrisation, the Parameter field in the tool specifies the
used IEC61850 Data (for example LD0.PHIPTOC1.StrValMult.setMag.f). The syntax
is [Logical Device].[Logical Node].[Data Object].[Data Attribute].

Adding new parameters for Modbus IEDs

If a connectivity package is not available for Modbus IEDs, the parameters can be added
manually. When Parameter Filtering Tool is launched from Modbus IED on SAB600
for the first time, there are no configured parameters in Parameter Filtering Tool. You
can add new parameters using the Add Parameter Form window.

To add a new parameter:
1. Click Add Parameter in the Parameter Filtering view. The Add Parameter Form

window opens, see Figure 3.9-3.
2. In the Add Parameter Form window, fill in the information of the parameter.
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• For the Modbus IED Read only parameter, specify only the parameter address.
• For Write and Read And Write parameter, in addition to the parameter address,

you may need to specify the password address and value, if the password is
enabled in the IED. You may also need to specify the execute address and
confirm address, if required by the IED.

3. After you have added all the necessary information, click Apply to add the parameter
to the Parameter Filtering view.

Add Parameter for Modbus IED.bmp

Figure 3.9-3 Adding a parameter for Modbus IED

Exporting parameters

You can export the information of the selected parameters to an Excel or XML file.

You can import the XML file back to the tool for other IEDs,
but you cannot import the parameters back to the tool from
the Excel file.

To export the parameter selection:
1. Select the parameters you want to export.
2. Click Export. Select the file type (Excel or XML).
3. Select the folder where you want to export the file and click Save.

34

1MRS756740Station Automation COM600 3.5

HMI Configuration Manual



Export.bmp

Figure 3.9-4 Exporting XML file

Importing parameters

With the Import function it is possible to import an existing Parameter Filtering Tool
configuration for example from another computer. An XML file created with the Para-
meter Filtering Tool can be imported into another device or project using this tool.

Disturbance data upload3.10.

The basic support for the disturbance data upload (data upload and conversion to
COMTRADE format) is implemented to each OPC Server. Protocol and device-specific
differences are hidden from the OPC client. The files are stored temporarily to the
COM600 computer, where they can be transferred further using for example ftp. COM600
has a possibility to activate the disturbance data upload from the IED and to receive the
file into the computer where HMI is run.

If the IED and the OPC server used for communication support disturbance data upload,
the properties for configuring the function can be found from the corresponding OPC
server user's manual, see 1.8, Related documents.
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Project-specific localization3.11.

With SAB600 you can modify the project-specific texts that are displayed in HMI. Static
HMI texts, for example menus and headers, can be translated by the local ABB. For
more information on localization, contact your local ABB representative.

To localize objects in the substation structure or communication tree:
1. Select the object you want to modify.
2. Right-click the object and select Rename.
3. Modify the name of the object.

To localize object properties:
1. Select the object you want to modify in the Substation or Communication structure.
2. Right-click the object and select Properties. The Object properties window opens.
3. Modify the text properties of the object.
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Appendix 1

Single Line Diagram symbols

Table A1-1 Single Line Diagram symbols
RemarksANSI2

represent-
ation

IEC rep-
resenta-
tion

ANSI rep-
resenta-
tion

Description

Annotation

Alarm indicator in a branch of the
substation. Use at any level in the
structure to indicate alarms gener-
ally, or a specific alarm. The
indicator is not visible in the web
view when there are no active
alarms.

Alarm Indicator

Binary indicator (on/off, auto-
matic/manual, X/not-X, and so
on). It can also be used to send a
command.

Two State Switch

Hyperlink to external information
source, such as a web page or a
local file on COM600.

Files should be stored under
C:\Program Files\COM600 GW
SW\WebHMI\UserDocs\. The total
size of the files should not exceed
100 MB. Link syntax for local files
is: http://<COM600 IP
address>/HMI/UserDocs/<file-
name>

Launch Web Page

Use to send a single command to
one target.

Push Button

Use to launch an application
external to COM600

Application Launch

Measurement Text Box

ViaPoint

Connectivity Node
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RemarksANSI2
represent-
ation

IEC rep-
resenta-
tion

ANSI rep-
resenta-
tion

Description

Circuit breaker – Inter-
mediate position

Circuit breaker – Open
position

Circuit breaker – Closed
position

Circuit breaker – Bad
(faulty) position

Disconnector – Interme-
diate position

Disconnector – Open
position

Disconnector – Closed
position

Disconnector – Bad
(faulty) position

Truck – Intermediate
position

Truck – Open position

Truck – Closed position

Truck – Bad (faulty)
position

Three State Switch
(Left, earthed)

Three State Switch
(Right, earthed)

Load breaker – Interme-
diate position

Load breaker – Open
position

Load breaker – Closed
position

Load breaker – Bad
(faulty) position
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RemarksANSI2
represent-
ation

IEC rep-
resenta-
tion

ANSI rep-
resenta-
tion

Description

Contactor – Intermedi-
ate position

Contactor – Open posi-
tion

Contactor – Closed
position

Contactor – Bad (faulty)
position

Primary winding: on top. Second-
ary winding: below. All composing
elements exist as individual sym-
bols.

Power Transformer with
two Windings and no
Tap Changer

Primary winding: on top. Second-
ary winding: below. All composing
elements exist as individual sym-
bols.

Power Transformer with
two Windings and Tap
Changer

Primary winding: on top. Second-
ary winding: below left. Tertiary
winding: below right. All compos-
ing elements exist as individual
symbols.

Power Transformer with
three Windings and no
Tap Changer

Primary winding: on top. Second-
ary winding: below left. Tertiary
winding: below right. All compos-
ing elements exist as individual
symbols.

Power Transformer with
three Windings and Tap
Changer

Voltage Transformer
(measurement)

Current Transformer
(measurement)

Capacitor

Reactor

Generator

Motor

In-feeder
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RemarksANSI2
represent-
ation

IEC rep-
resenta-
tion

ANSI rep-
resenta-
tion

Description

Out-feeder

Earth symbol

Bay Switch Indicator

Station Switch Indicator

Display Voltage
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Appendix 2

SAB600 Toolbar

DescriptionSymbol

Displays the Substation and Communication Structure in the Project Explorer window.

Displays the Object Properties window.

Displays the messages in the Output window.

Displays a list of the object types.

Selects an object in the SLD Editor window.

Enables navigation of the SLD Editor window using a mouse.

Displays a grid view in the SLD Editor window.

Zooms in/out the SLD Editor window.

Opens the direct link tool.

Rotates the selected objects left in the SLD Editor window.

Rotates the selected objects right in the SLD Editor window.

Used to draw rectangles around grouped objects
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Appendix 3

Logical nodes and primary objects

Logical nodes can be connected to primary objects according to the following table. If
no specific function is written in the Comment column, the connection is used for dis-
playing the substation structure based on identification for the events and alarms.

Table A3-1 Logical node classes and primary objects
CommentMandatoryLN ClassPrimary object

Substation

Loc data used for sta-
tion/remote switch
state

LLN0

SIMG

CALH

M*

G*

Q*

Voltage Level

SIMG

CALH

M*

G*

Q*

Bay

Loc data used for bay
local/remote switch
state

LLN0

LPHD

SIMG

SARC

SIML

SPDC

CALH

M*

P*

R*
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CommentMandatoryLN ClassPrimary object

G*

T*

Q*

Circuit Breaker (CBR)

XCBR

Pos data used for
switch device position
and control.

MandatoryCSWI

RREC

Rel data used for syn-
chronism-check status
in control dialogs.

RSYN

EnaOpn and EnaCls
data used for interlock-
ing status in control
dialogs.

CILO

PTRC

SIML

CALH

G*

Disconnector (DIS)

XSWI

Pos data used for
switch device position
and control.

MandatoryCSWI

RREC

Rel data used for syn-
chronism-check status
in control dialogs.

RSYN

EnaOpn and EnaCls
data used for interlock-
ing status in control
dialogs.

CILO

PTRC

SIML

CALH

G*

Voltage Transformer
(VTR)

TVTR
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CommentMandatoryLN ClassPrimary object

CALH

G*

Current Transformer
(CTR)

TCTR

SARC

SPDC

CALH

G*

Q*

Power Overhead Line
(LIN)

ZLIN

CALH

G*

Rotating Reactive
Component (RRC)

ZRRC

CALH

G

Surge Arrestor (SAR)

ZSAR

CALH

G

Thyristor controlled
frequency converter
(TCF)

ZTCF

CALH

G

Thyristor controlled
reactive component
(TCR)

ZTCR

CALH

G*
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CommentMandatoryLN ClassPrimary object

Power Transformer
Winding (PTW)

G*

Powered rules for the
Incoming Feeder Line
can be configured in
the SLD editor. See
3.5.1 Configuring the
powered state for
incoming feeder and
generator.

Incoming Feeder Line
(IFL)

CALH

G*

Q*

Powered rules for the
Generator can be con-
figured in the SLD
editor. See 3.5.1 Con-
figuring the powered
state for incoming
feeder and generator.

Generator (GEN)

ZGEN

G*
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